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 ACTIVITY 1 – Patient Information Request (PIR) Request Queue 
 

Learning Objectives 

At the end of this activity, you will be able to: 

 Retrieve a PIR Request List by Location/Facility 

 Create/Print a PIR Request Pull List using Discern Reporting Portal 

 Change the Status of a Request 

 

 Activity 1.1 – Retrieve a PIR Request List by Location/Facility 

Within the Citrix StoreFront, select the Request Queue icon . 
 

The Request Queue window opens.   

  

 Search for the request(s) by clicking on the Search icon . 

  
 

The Request Queue Search dialogue box will open. 

 
 

Under Facilities, select the main Facility (i.e. LGH or SGH). 
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By clicking on the Select button, all areas within Facilities will be checked.  You will rarely want to 
do that, as all facilities across the three HO’s (VPP) will eventually be listed. 

 

  
 

Under Request, you can select by Request number (if you know it) or View all requests by 
clinic/area or facility. 

 
 

Under Search Criteria, you can select by: 
 

o Patient 
o Tracking ID 
o Requesting location 
o Current location 
o Requester 
o Request date/time range 
o Required date/time range 
o Status 
o Request type   

    

 

Typically, if you are creating a list of charts to pull, you may want to filter by the specific location(s) 
under Facilities and the Request date along with the Status of Logged and Request type of 
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Patient Care.  Once you have completed the fields for your Request Queue Search, click OK. 

For today’s example, we’ll run a list of charts required for March 5th, 2018 that were logged.  
Remember to enter the time as well from 0001H - 2359H. 

Your screen should look like this: 

 

  

You will get a listing of all the charts requested and your screen should look similar to this. 

 

 

 

 

 

 

To see more patient details, you will need to expand all of the “+” to the left of the Request ID’s.  
Your Screen should look similar to this. 
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 You can sort in ascending/descending order by clicking on any of the headings. 

 

It is recommended that you keep the Request Queue open if you can, as all the search settings 
and results remain unchanged.  Once you close the application, the results may var as more 
requests can be added. 

While you have the screen open, you can change the request status from Logged to Processing.  

To change multiple requests, select the Change Batch Request icon . 

 

 

The Change Multiple Requests dialogue box will appear. 

 
 

Highlight each request by pressing the shift key and clicking on the applicable requests. 
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Under Request status, select Processing. 

  

 
 

 

Click the Apply button .  The requests from the list will update the status to the new 
status but will not disappear from the list.  If possible keep the screen open and do not close it. 

 

 

 

 

 

 

 

 

 

 

 

 

 Activity 1.2 – Create/Print a PIR Pull List from Discern Reporting  

To run a complete list for your facility for a specific date/date range, it is recommended that you use the 

Note: You would not print your chart pull list from the Request Queue as there 
are no historical MRN’s listed.  You will need to print the pull list from 
Discern Reporting Portal. 
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RM-Patient Info Request (PIR) Pull List.  This report will list all charts in TD order by clinic/area.   
 
This report can be run in a Printable PDF format or an Exportable (CSV) format. 
 
If you require a list of charts for a specific clinic/area, run the report as a Printable PDF Format and print 
only the page(s) required.  
 

From the Citrix StoreFront, click on the Discern Reporting Portal icon  . 
 

From the Reporting Portal window, select RM-Patient Info Request (PIR) Pull List. 

 Click Run Report. 

  

 

The Discern Prompt dialogue box will appear. 
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Under Output to File/Printer/MINE, this defaults to MINE, which is a screen view. 

  

 

Under Output Type, select how you want to view the report – Exportable (CSV) or Printable 
(PDF). 

 

 

Select the Health Organization, currently defaults to Vancouver Coastal Health Authority. 

  

 

Under Site, choose the appropriate facility.

 

 

 

 

 

Select the Start and End Date, using the down arrow keys to show the calendar. 

 

 

Under Chart Status, select Processing if you changed the status in the Change Multiple 
Requests dialogue box earlier, otherwise select Logged.  The report is always defaulted to 
Logged. 

 

 

 

If you wish for a page break for each clinic/area, select the Page Break on Requesting Location 

 
Note: All clinics/areas are rolled up to the main facility.  For example, Lions 

Gate Hospital will include all clinics/areas within LGH, Hope Center, 
North Short Hospice and Evergreen House). 



Health Information Management – Clerk III 
  
 

10  
 

12 

13 

11 

box. 

  

 

If you want to return back to the same report parameters, after viewing/printing the report, you will 

need to click on the Return to prompts on close of output.  Click on the Door icon  to 
“Close” the report and bring you back to the prompt screen.  Otherwise, when you close out the 
report, it will take you back to the main Discern Reporting Portal window. 

 

 

Click the Execute button . 

 

 The Printable (PDF) report should look similar to this. 

  

 

The Exportable (CSV) report should look similar to this. 

   

 

To print from the Printable (PDF) or Exportable (CSV) report, click on the print button . 
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Click on the Door icon  to “Close” the report and bring you back to either the prompt screen 
or to the main Reporting Portal window. 

 

 

 

 
  

 
Note: Use this PIR Pull List Report created from the Discern Report Portal to 

write any notations regarding exceptions (i.e. Charts not found).   
Once chart pull completed, place this report with the pile of charts to go 
to the requesting location. 
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  Activity 1.3 – Change the Status of a Request 

Once the report has been printed/viewed and prior to pulling the charts, you should batch update all 
of the requests to the status of “Processing”.  This is important for those sites who have multiple 
staff who pull charts for requesters, as this informs other users that you are working on these 
requests so that duplication of work is prevented. 

Best practice is to leave the Request Queue application open to keep the search and results static 
to assist in updating the same set of results as a batch. 

As the Request Queue displays the Request Number, and you have to expand each Request 
Number in order to see the patient chart details, it is recommended that you use the PIR Pull List  to 
cross-reference the Historical MRN with the Request ID. 

 
After you have pulled all the charts, go back to the Request Queue PIR list (if you’ve left it opened). 
From here, if there are any charts that are not available, click on the applicable Request ID that 
the patient’s chart is not available for, then select the applicable reject reason under Rejected 
reasons.   

 

 
In keeping with the SOP, the only reject reasons we use are: 

  
 
 

Once you have selected a reject reason, click on the Save Request icon. 
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If you select Other – Note, you must add a note by clicking on the request and select View/Add 
Note icon to add comments as to why the requested chart is not available. 
 
Remember that if you click Permanent note, it doesn’t mean the note will stay permanent.  It will 
only prompt someone who tries to delete that note, as to whether or not they want to delete the 
note.  The Print on deficiency slip is dithered. 
 
Once the Note has been completed, click Save and Exit. 
 
 

      
 
 

For all charts that are unavailable, continue with the above steps until you have identified all the 
unavailable charts. 

  

For the remaining charts that are available, you can change multiple requests by selecting the 

Change Batch Request icon . 
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The Change Multiple Requests dialogue box will appear. 

 

 
 

Highlight each request by pressing the shift key and clicking on the applicable requests. 

  

 
 

Under Request status, select Complete. 

  

 
 

 

Click the Apply button .  The requests from the list will update the status to the new 
status but will not disappear from the list.  Click close X to exit. 
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 ACTIVITY 2 – Patient Lists 
 

Learning Objectives 

At the end of this activity, you will be able to: 

 Have an Overview of What Patient Lists are 

 Build a Custom Patient List 

 Add / Remove Patients from  Patient Lists 

 Modify / Delete Patient Lists 

 Proxy a Patient List to Another User 

 Print a Patient List 

Overview 

For HIM, Patients Lists will be created in PowerChart by Clerk III’s and Clerk IV – ROI staff to provide 
access to researchers and external ROI requesters to specific patient charts/encounters . By building 
a Custom Patient List and proxying access to external requesters, it limits their ability to do a broad 
search in Cerner PowerChart, which is in keeping with privacy laws. 

There are ten different types of lists, some of which are populated automatically by the system, while 
the Custom list is built manually.  For example, the computers located in the inpatient areas are 
defaulted to display the Patient List of the Location of the computer – computers in 3 East at LGH will 
display the LGH 3 East Location Patient List. 

You can build multiple Patient Lists and have up to ten of those available as Active Patient Lists and 
displayed as tabs in the Patient List view.   

 

 Activity 2.1 – Build a Custom Patient List 
 

In PowerChart, click on the Patient List tab . 
 

The Patient List window will display.  Click the List Maintenance wrench icon . 

  

The Modify Patient Lists dialogue box opens.  Available and Active Lists will display in the left and 
right pane respectively.  Click New to create a new list. 
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The Patient List Type dialogue box opens and displays the Patients Lists that are available for you 
to create.  Single-click on Custom and click Next. 

 

 
 

The Custom Patient List dialogue box opens.   
 
The left pane displays filter options while the right pane narrows down the options for your lists.   
 
For HIM, the use of these filters will be very minimal.   
 
Click in the Enter a name for the list field and type in the name of your Custom Patient List.   
 
Click Finish to complete the action. 

 

   
 

 
Table of Standard Naming Convention: 

 

External Requester Standard Naming Convention Example 

Research Research # - Principal Researcher’s Name Research 1 – Albert Einstein 

ROI Requester Requester’s Organization – Requester’s Name MCFD – Katniss Everdeen 
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The Custom Patient List will now appear as an Available list in the left-hand pane.   

To be able to view this list in PowerChart you will have to move it to the Active lists in the right 
pane.  

 Single-click on the Custom Patient List in the Available lists pane 

 Click  to move it to the Active List pane 

The Custom Patient List will now appear as an Active list and is available to view in PowerChart. 

 Click OK to close the box. 

 

   

  

Your Custom Patient List will display in your Patient List window. 

 

  
 
 

 Activity 2.2 – Add / Remove Patients from Patient Lists  
 

Adding Patients 

 

In the Patient List window, select the appropriate Patient List by clicking on the tab. 
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Click on the ‘Add Patient’ icon  

 

The standard Patient Search window opens. 

Search for the patient and select the appropriate encounter using any of the criteria displayed in 
the left-hand pane. 

 

 

 

 

 

The patient’s encounter you selected is now displayed in your list. 

 Continue this step to add all of the patients and their encounters on your list. 

 

Note: The current build only allows you to add patients by encounter, not the 
entire patient record. 
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Removing Patients 
 

From the Custom Patient List, single-click to highlight the patient encounter you wish to remove 
from the list. 

Click on the Remove Patient icon . 
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 Activity 2.3 – Modify / Delete Patient Lists  
 

Modifying Patient Lists 
 
 

You can modify any of the properties of a Patient List after you have created it. 
 

In the Patient List window, select the appropriate Patient List by clicking on the tab. 

  

 

Click on the Properties icon . 

 

The Customize Patient List Properties dialogue box opens.   

As HIM use of these filters will be very minimal, changes would typically be limited to changes to 
the names of the Patient Lists as needed. 

 Click OK to complete the activity. 
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Deleting Patient Lists 
 

Once the researcher and/or ROI requester is completed reviewing their list of patient charts in 
PowerChart, you can delete the Custom Patient List. 

From the Patient List view, click the List Maintenance wrench icon . 

  

The Modify Patient Lists dialogue box opens.   

Select the Custom Patient List you wish to delete from the Active lists pane and click to move 
it to the Available lists pane.  

            
 
Right-click on the Custom Patient List you wish to delete under Available lists. 

Click Delete Patient List. 

You will be prompted to select Yes to permanently delete the Patient list. 

  

The Custom Patient List will no longer appear in your Patient List view.   

 
There is no way to recover a deleted list; therefore, it is important to ensure that the external 
requester/researcher is completed their review prior to deleting their list. 
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 Activity 2.4 – Granting Proxy to a Patient List  

You can proxy any Patient List to another user with the assigned privileges. 

From the Patient List window, click on the Properties icon . 

 

The Customize Patient List Properties dialogue box opens.  

Click the Proxy tab to open the Proxy Tool. 

Click New. 

  

 

From the Customize Patient List Properties dialogue box, select the Provider radio button. 

Click the magnifying glass to the  right of the provider field. 

Enter the last name of the researcher’s name and/or the external ROI requester’s name you wish 
to proxy the list to. 

Click Search. 
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Single-click on the appropriate name. 

Click OK.  

 
 

 

Click on the down arrow to the right of the Access field. 

 
From the drop-down menu, select the type of access you wish to grant: 

 Full Access: Read, add patient, remove patient and delete list. 

 Maintain:   Read, add patient and remove patient 

 Read:  Read ONLY. 
 

For researchers and external ROI requesters, select Read. 
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Enter the start and end date of the proxy.   

If you plan for this Patient List to be shared for a long-term, pick a date well into the future.  For 
researchers, pick the valid research dates that are specified on the Institutional Approval or 
Research Extension Form. 

 When you have completed all the fields, click Apply. 
 

   
 
 

Your proxy will be displayed.   

You can either select New to add an additional proxy or click OK to complete the action. 

 

  
 
 

 
 

 
Note: To display the proxied Patient List in the researcher/external ROI requester’s 

Patient List window, you will have to move the list from ‘Available’ Patient Lists 
to ‘Active’ Patient Lists. 

Tip…click on the 
large down arrows to 
display a calendar. 
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Once the proxied Custom Patient List is an Active Patient List, it will display similar to the screenshot 
below.  The name of the Custom Patient List will appear with the name of the Researcher/External 
Requester with the HIM staff who proxied the list in brackets. 
 
The Researcher/External Requester will need to also make the list an Active Patient List in order to see 
the list. 

 

 
 
 
 

 Activity 2.5 – Printing a Patient List  

 

To print a Patient List, select the list from your Patient list window and click the Print button . 

 

  

 

The Print dialogue box will appear.  Your defaulted printer should display and click OK. 

 

  
 
 
 
 
 
 
 
 
 
 
  

 

Oncology (Athabasca, 
One) 
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 ACTIVITY 3 – Multiple Document (Batch) Scanning 
 

Learning Objectives 

At the end of this activity, you will be able to: 

 Have an Overview of the Document Imaging Workflow for HIM Batch Capture 

 Access the Kofax Capture 

 Understand the Batch Classes 

 Perform Document Imaging – Scan / Quality Control / Validation 

 

 

Overview 

Kofax Capture is a document scanning, indexing and extracting software solution that captures, classifies 
and extracts content from all types of paper documents and forms.  This application will interface with 
Cerner to perform Validation.  HIM Departments will be utilizing Kofax Capture for batch scanning.  A 
“batch” is defined as documents that are grouped together in preparation for scanning.  This can be a batch 
of documents for one patient (Inpatient discharges) or a batch of documents for multiple patients 
(Emergencies, Day Surgery or Loose Reports).  Note that Ambulatory Clinics and smaller HIM departments 
may use Cerner Single Document Scanning functionality to scan individual documents into Cerner; 
however, HIM will be responsible to audit, store and destroy these documents. 

HIM Batch Capture Workflow: 

 Chart / Loose Reports Received 

 Prep 

 Scan 

 Recognition (Automated) 

 Quality Control (QC) 

 Remote to Central Site Batch Transfer – (Automated) 

 Validation (via Citrix) 

 Export (Automated) 

 Batch Indexing (Automated) 

 Document in Cerner Millennium – PowerChart for Viewing 

Post go-live, patient charting/documentation will either be direct entry into PowerChart or by using clinical 
forms printed through WebForm Imprint.  These forms will be barcoded with patient encounter and form 
identification, similar to our current “addressograph labels”.  These barcoded forms will be auto-
detected/indexed through Kofax.  However, we will continue to receive forms/documents that are external 
to the organization and these will need to have barcoded labels applied to them prior to scanning. 

Refer to the following Document Imaging SOP’s for details on the processing of charts/documents: 

1. Prepping 

2. Scanning 

3. Quality Control and Validation – Scanned Documents 
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 Activity 3.1 – Access the Kofax Module / Scan Documents 

 

From your desktop, click on the Kofax Capture 10.2 folder 

      
 
If you do not have this folder on your desktop, follow these steps to place on your desktop: 
 

a) Click on Start  / All Programs   
 

b) Click on the Kofax Capture 10.2 folder 

   
 

c) Right click and select Send to / Desktop (create shortcut) 
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From the Kofax Capture 10.2 folder double-click Scan. 

 

The Kofax Capture – Login screen will appear.  Enter your User ID and Password.  Click OK.  

 
 

The Configure Device Settings window will appear.  Click OK 

 
 

The Kofax Capture Scan window will appear.  Click on Cancel to close the Open Batch pop-up window 
and then click Create. 

  
 

 

 
Note: This screen shows the batches that have been already created. 
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 Included in your “batch” of documents, you will find: 

 Barcoded forms from WebForm Imprint. 
o Multi-page continuous forms. 
o Single-paged forms – same document type. 

 Non-barcoded forms (external forms). 
 
This batch of documents has already been prepped.  The typical steps involved in prepping include: 

 Removing staples and paperclips 
 Ensuring all pages are right-side up 
 Cutting off rough edges and repairing damaged pages 
 Arranging pages in the correct order for multi-paged documents 
 Ensuring patient’s name and FIN (encounter number) are correct on every page 
 For poor quality images, consider using a “Poor Quality Original” stamp on the page. 

 
Of note, you will see: 

 A Separator Sheet to separate bar-coded and non-bar coded documents. 

 A FaceSheet or an I Have Been Scanned document (if no FaceSheet provided) at the last page of 
the batch. 

 

 

Some Important Notes Regarding Barcoded Forms and Separator Sheets 

 

          Sample Standard Barcoded Form    Sample Separator Sheet 

 

 

 

 

 

 

 
 
 
 
 

 
Separator Sheet 

 
• Separator sheet will need to be deleted manually during Quality Control 

• Multiple separator sheets should not be used in one batch 

• Only used as a visual/physical split between barcoded and non-barcoded forms at the end of the batch 

• During prep, non-barcoded forms will be placed at the end of the batch 

• During the automated recognition process, forms are split/combined based on the barcode being 

detected 

• Non-barcoded forms at the end of the batch will be combined in one book with the separator sheet and 

will need to be manually split in QC. 

Note: The order in which documents are prepped is critical. 

Document Form Barcode 
– Recognition module 
extracts document type 
information from the 
document form barcode 

Patient Barcode –  
Recognition module extracts 
patient information from the 
patient barcode 

Separator Sheet – 
Recognition module will 
split on form barcode 

No patient label. 
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The Create Batch window will appear.  Select the Batch class: 

 

 

Batch Class Descriptions 

 

Batch Class Used For: Description 

Inpatient 
Ambulatory 

Single Patient: 

 Inpatient 

 Ambulatory 
 

Batch prepped for one patient, single encounter. 
Patient labels should be on front and back of every page. 
Patient information is sticky. 
Same document type barcodes will combine: 

 Consent Form followed by a Consent Form will combine 
(assuming matching form barcode). 

 Consent Form followed by a non-barcoded document will 
combine. 

Multi-paged documents should be placed in chronological order 
and grouped together. 

 Same document types that need to be separated should 
be prepped between another document so they will not 
combine.  

Non-barcoded forms prepped at end of batch with a separator 
sheet. 

Loose 
Reports 

Multi-Patient: 

 Day Surgery 
Loose Reports 

 Emergency 
Loose Reports 

 Loose Reports 
 

Batch can contain documents of different patients/encounters. 
Patient label should be placed on front and back of all pages. 
Splits on document type barcode.  
If document barcode is missing, documents will combine in QC: 

 Consent Form followed by a Consent Form will not 
combine (assuming match form barcode). 

 Consent Form followed by a non-barcoded document will 
combine.  

Multi-paged documents should be placed in chronological order 
and grouped together (manually combined in QC). 
Non-barcoded forms prepped at end of batch with separator 

 

 LGH/SGH Ambulatory 

 LGH/SGH Day Surgery Loose Reports 

 LGH/SGH Emergency Loose Reports 

 LGH/SGH Inpatient 

 LGH/SGH Loose Reports 

 LGH/SGH Release of Information  

 LGH/SGH Same Doc Type 
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sheet. 

Same Doc 
Type 

This batch consists 
of documents 
belonging to the 
same document type 
(i.e Consent Forms) 

Batch can contain documents for different patients/encounters. 
Patient label placed on front and back of all pages. 
Splits on patient label barcode. 
If patient barcode is missing the document will combine with 
previous patient barcoded document: 

 Consent Form followed by a Consent Form will not 
combine for the same patient (assuming matching form 
barcode). 

 Consent Form followed by a non-barcoded document type 
will combine.  

Multi-paged documents should be placed in chronological order 
and grouped together (manually combined in QC). 

Release of 
Information 

Release of 
Information  
Correspondence 

Batch can contain documents for different patients/encounters. 
Patient label placed on front and back of all pages. 
Splits on patient label barcode.   
Hardcoded ROI Doc Type. 
Release of Information correspondence will all be within one book 
per patient. 

Note: All documents will be scanned in grayscale.  If your site has colored documents that have been 
identified as needing to be scanned in color (i.e. clinical impact/significance), you will need to pull 
these out during prepping and scan them separately by changing the Scanner Profiles under 
the Home tab to Color. 

 

Place forms as indicated on scanner onto the scanner tray. 

 

Click Scan . 

 

The scanned documents will appear on the window with thumbnails on the left hand column. 
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Complete the Batch Capture Coversheet. 

  

 

Complete the following: 

 Site 

 Batch ID 

 Scanner #: 

 Batch Class 

 Prepped By 

 Scanned By 

 Comments 
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Click on the round Kofax button  at the top left corner.  Choose EXIT. 

 

 

After scanning all of your batches, the Scan dialogue box will appear.  Click Close and then it will ask 
you to confirm in another box.   

Click Yes. 

Batch ID 
(1174) 
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The next process is called Kofax Recognition which is an automated process for indexing the scanned  

documents based on the barcodes. 

 Activity 3.2 – Quality Control 

Overview 
 
In this module you will examine the batch for quality: 

 No pages are missing 

 No blank pages 

 Images are good quality 

 Documents are separated correctly 

 Documents are rotated correctly 

 Color pages are rescanned in color if required 

 All information on the page is readable and matches the paper copy 

 Books are broken up appropriately 
 

Functions available: 
 

 Replace Images 

 Insert Pages 

 Delete Images 

 Rotate Images 

 Move Images 
 

Document Form Barcode 
Recognition module extracts 
document type information from the 
document form barcode 

Patient Barcode 
Recognition module extracts patient 
information from the patient barcode 
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Open Quality Control from your desktop shortcut.  If you don’t already have this on your 
desktop, click on Kofax Capture 10.2 folder on your desktop.  Double-click on Quality Control. 

  

 

The Kofax Capture – Login box will appear.  Enter User ID and Password – Click OK. 

 

 

 

The Kofax Capture Quality Control window will appear displaying all open batches that have been 
scanned. 

  
 

Select the Batch ID that you wrote on the Batch Capture Coversheet – click on the Date & Time and/or 
Name column to sort and find your Batch ID.  Click OK. 
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The scanned documents will appear on the window.  The cursor will always land on Page 1, Image 1.  

 

Compare each paper page with the screen page to ensure they are identical (see QC/Validation SOP). 

Click the “Enter” button after every page. 

Colored tray represents a batch. 

 

Blue numbered books represents 
document types 

 

Within each book are the single 
pages of that document type. 
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Check books are accurately separated. 

 
  

What are Books? 

 Images are broken down based on the logic of the batch. 

 Books consist of images that belong together. 

 Each book should have a single patient and a single document type. 
Examples: 
 Example 1: Daffy Duck has a 3 page Progress Note followed by a 2 page Physician Order. 

 How many books will there be? 
 2 books 

 How many pages will be in each book? 
 Book 1 = 3 page Progress Notes 
 Book 2 = 2 page Physician Orders 

 
 Example 2: There are 7 pages of Progress Notes in a row. 

  The first 4 pages belong to Madonna, the last 3 pages belong to Cher. 
 How many books will there be? 

 2 books 
 How many pages will be in each book? 

 Book 1 = 4 pages for Madonna 
 Book 2 = 3 pages for Cher 

A blue check mark will appear over the pages that you have QC’d.    

In QC, you have the ability to split, merge, insert and delete pages. 
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Kofax Shortcut Keys 
The grid below displays the shortcut keys for Kofax for managing the scanned documents. 

 
 
Splitting Documents 

Click on the page to split and click the Split button.  The system will now move the page to a new book. 

 
 

Merging Documents 

If you see a page belonging to the same document prior you will need to merge these to the same book 
as they belong together (only applies to multi-paged documents). 

Click the page that you want to merge and drag and drop the page into the book in the correct sequence 
that you want it to display.  The system will now move the pages to the same book. 

 

 

 

Note: Always delete Separator Sheets. 
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Once every page is checked, click Close. 

 
 

Confirm to close.  Click Yes. 

 
 

The Open Batch window will re-appear to allow you to continue QC’ing any other batches you scanned. 

If you want to move to Validation, click Cancel. 

 
 

Click on the round Kofax button  at the top left corner.  Choose EXIT. 
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 Activity 3.3 –Validation 

Overview 
The Validation module runs from Citrix. During this step, extracted values for patient information and 
document types are validated against the database and the documents are then indexed according to the 
following fields: 

 FIN – Encounter Number 

 MRN – Medical Record Number 

 Patient Name – Last Name, First Name 

 Document Type 
 A parent folder can consist of many document types.  For example the parent folder ‘Consent 

Procedure’ will contain document types such as:  Acute Care Services Consent – Surgical 
Operation, Special Operation, Special Procedure or Treatment and Special Considerations:  
Consent for Personal Health Information Access.  Each WebForm Imprint form will have a 
parent folder name listed in the header. 
 

Purpose of Validation: 

 Review/validate the accuracy of the index boxes for the scanned documents in a batch with the 
database. 

 The values in the index fields will be used to place the documents in the appropriate patient chart (on 
the correct encounter) under the appropriate document type. 

 In Validation the system only allows the users to view the first page of each book since all images in a 
book belong to the same document type. 

 
Validation Process: 

 Index Fields are displayed on the left hand side of the screen. 

 You should be ensuring that both patient information is correct as well as the appropriate document 
type selected. 

 Document Types are extracted from the Document Type Barcodes and can be added or changed 
using the Document Type Search Window. 

 Patients are extracted from the Patient Label and can be added or change using the Patient Search 
Window. 
 

 There are two ways to process within Kofax Validation. This is determined based on the Batch Class: 
 
Manual Validation: 
o During manual validation, the user tabs through all the boxes and verifies information and matches 

the documents 
o The 1st page of each book will display when tabbing 
o Indexed data can be corrected, if necessary 
o Encounter search window or document type search window will open if there is missing 

information 
o After all documents have been tabbed through, module will ask to save and submit the batch. 
 
Auto Process Documents: 
o Automatically processes patient information and document type 
o Use only for the Inpatient or Ambulatory batch classes since documents could combine to wrong 

encounter if patient label didn’t read properly 
 Risk - 1st page of new encounter document could append to last page of previous 

encounter document 
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Launch via the Citrix StoreFront Index shortcut. 

 
 

The Kofax Capture – Login box will appear.  Enter User ID and Password – Click OK. 

 
 

The Open Batch window will appear.  Select the desired batch from the list.  Click OK. 

  
 

Enter Millennium user credentials if required.  However, Single Sign-On should not require user 
credentials to be entered. 
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The window will display three panes, depending on your screen size, expand the panels using the click 
and drag function, so that you can see all the panes.  Maximize your screen. 

 

        
 

 
If all of the forms have both the document type barcode and patient barcode, and they are recognized, 
then these values will populate the Index Fields automatically.  

 

    

 

AUTO PROCESS 
OR 
TAB 
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The system will then move to the next document that has missing fields.  If there are NO barcodes or the 
barcodes were not recognized, you will have to tab manually through each Index Field and either 
manually apply the MRN and/or the Document Type 

 
 

To manually Validate documents that have a document type barcode, but no patient barcode, you will be 
prompted to select a patient when you are in the blank MRN index Field or you click the Select Patient 

button  on the left-hand pane to confirm patient and select correct encounter from 
the Encounter Search window and click OK.   

  
 

To manually Validate documents that do not have a Document Type barcode, you will be prompted to 
select a Document Type from the left-hand pane.  Click on the ellipsis to do a Document Type Search. 
Under Document Alias, enter the number under the Document Type barcode if available.  If the 
Document Alias is not available, you can search by Document Type or Subject. 

   

Note: There is an Auto Process Documents button which will automatically index the 
forms if all of the Index Fields were automatically populated.  It is at the discretion 
of the Records Management Manager to determine when an end user can begin 
to utilize the functionality of Auto Processing in the step of Validation.” 
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After all documents have been validated, click Save. 

 

  
 

The Kofax Capture Validation window will appear.  If you want to re-review, click No, if you want to move 
to the next batch click Yes. 

 

  
 

To re-review, use the arrow buttons at the bottom of the screen to move through the documents. 
By hovering over the arrows there will be a description of what each arrow function is. 

 

 
 
 

 To end the session, click Close . 

 
  

Note: You can adjust the document, if it does not appear in an upright position 
by using the Rotate arrows. 

 



 

45  

 ACTIVITY 4 – Task Queue 
 

Learning Objectives 

At the end of this activity, you will be able to: 

 Have an Overview of the Task Queue 

 Identify Task Types associated with your role in HIM 

 Set and View Task Queue Preferences / Options 

 Manage the Assembly – Residential Task Queue (Pass/Complete a Task) 

 Manage the Pre\Scan Reconciliation Task Queue (Pass/Transfer/Complete a Task) 

 Change the Status / Remove / Add Encounter or Notes to a Task 

 Preview and Print Reports 

 
Overview 

The Task Queue in HIM ProFile manages the creation, modification, and completion of tasks required by your 
organization to fulfill records management activities. Rules have been built for each patient encounter type so 
that the task queues are automatically created. The order of tasks can include prerequisites, for example, 
chart assembly/prep and scan must be completed prior to QA.  

The following is a list of the available Task Types available in the Task Queue and the associated HIM roles: 

Task Type HIM Role 

Assembly - Residential HIM Clerk III 

Prep/Scan - Reconciliation HIM Clerk III 

QA – Day Surgery HIM Clerk IV – Record Completion/QC 

QA - Inpatient HIM Clerk IV - Record Completion/QC 

For Review All HIM Roles, except Clerk IV - ROI 

 
 
It is important to note the following: 
 

 For the Assembly – Residential task type, the Task Status will need to be manually changed to 
“Complete” after the paper chart has been assembled. 
 

 The Prep/Scan – Reconciliation task type is to be used to reconcile any paper charts/chartlets that 
have not been prepped / scanned into the system.   
o The system has been built to automatically remove prep/scan tasks from the Task Queue after 

the system detects a Facesheet or an “I Have Been Scanned” document that is placed at the 
end of each patient encounter when scanned. 

o If after investigating, and there are no paper documents associated with an encounter, you can 
transfer the task to the applicable QA task.  

o  
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 Activity 4.1 – Set and View Task Queue Preferences / Options 

 

From the View menu select Options. The Options window is displayed. 

  

 

Task Queue preferences for HIM include filtering by Status.  Under the View tab, select Hide tasks of 
this status and select Complete.  This will set your preferences to only view outstanding tasks. Click OK. 
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 Activity 4.2 – View a Task Type 

From the Citrix StoreFront, select the Task Queue icon  . 

The ProFile Task Queue window will open and look similar to this. 

  

Select the Facility by clicking on the drop-down arrow.  Facilities are listed in alphabetical order. 

  

Click Choose Task Type (…) on the toolbar.  The Task Types dialog box is displayed. 

 Select the Task Type of Assembly – Residential and click As of. 

 

The selected Task Type or Task Types are displayed and your screen will look similar to this. 
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 Activity 4.3 – Manage the Asembly - Residential Task Queue 

Residential (ECU) charts will remain in paper.  They will continue to be assembled as we do today. 

Utilize these tips to manage the Task Queue efficiently and easily: 

 Click a column heading to change the order in which the data is displayed (ascending/descending 
order).  Always click on the Discharge Date column to show the oldest tasks at the top.  These are the 
priority for following-up on and will be denoted with a red color under the Task Age Indicator if it is 
considered “overdue”. 

 You can rearrange the column order by dragging and dropping the column headers to where you want 
them to display. 

 Adjust the width of a column by clicking the line separating two column headings and dragging until 
the column is the size you want. 

Change the Status of a Task 

 

Once you have completed assembling a residential chart, you can change the status of the task.  

Select the task you want to change from the list of tasks displayed. 
 

  
 

You can change the status by using the Task menu and selecting the status, right-clicking on the 
selected chart and select the status or by clicking on the buttons on the toolbar.  For Assembly – 
Residential, you will only use either Complete or Pass. 

                

 

Click Pass on Task  

Click Complete Task  

 

OR 

 

OR 
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Passing a Task 
 

You would select Pass on a task in the cases where the assembled residential chart requires someone 
else to analyze/check the assembly order (i.e. new staff in training). 

 

To pass on a task, select the task from the Task Queue and click Pass on Task  on the toolbar. 
 

The Pass on task dialog box appears.  Select a Pass on task reason and click OK. The task is displayed 
with a task status of OnHold. 

  

 

 

Completing a Task 
 

When you have completed assembly of the residential chart, you want to remove this from the Task 
Queue by changing the status to Complete. 

 

To complete a task, select the task from the Task Queue and click Complete Task  on the toolbar. 

  

The Complete task dialogue box will appear with the Completed date and time.  Click OK.  The task will 
now drop out of the Task Queue. 

 

 

Note:  After you refresh the application, the task status will change to On Hold. 
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 Activity 4.4 – Manage the Prep\Scan Reconciliation Task Queue 

Most of the Pre\Scan tasks will automatically be completed as the paper chartlets/documents are 
scanned into the system. 

However, in the cases where they are not automatically dropped out of the Task Queue, you will have to 
investigate further (i.e. no paper documents received, documents were scanned but didn’t have a 
Facesheet or an “I Have Been Scanned” document). 

Of note, if you notice that the Discharge Date is blank, that indicates that this encounter has been 
cancelled and this task can be “Completed”. 

 

Change the Status of a Task 

 

Select the task you want to change from the list of tasks displayed. 

 
 

You can change the status by using the Task menu and selecting the status, right-clicking on the 
selected chart and select the status or by clicking on the buttons on the toolbar.  For Pre\Scan 
Reconciliation, you will only use either Pass or Transfer. 

                

 

 

Click Complete on Task  

Click Pass on Task  

Click Transfer Task  

OR 

 

OR 
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Completing a Task 
 

Only Complete a task when the Discharge Date is blank, indicating that the encounter was cancelled. 
 

To complete a task, select the task from the Task Queue and click Complete Task  on the toolbar. 

  

The Complete task dialogue box will appear with the Completed date and time.  Click OK.  The task will 
now drop out of the Task Queue. 

 

 

 

 

Passing a Task 
 

You would select Pass on a task in the cases where the scanned documents requires someone else to 
do some further analysis/review. 

 

To pass on a task, select the task from the Task Queue and click Pass on Task  on the toolbar. 
 
 

The Pass on task dialog box appears.  Select a Pass on task reason and click OK. The task is displayed 
with a task status of OnHold. 
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Transferring a Task 
 

In the cases where there were no paper documents associated with a patient’s encounter, you would then 
transfer the task to QA – Inpatient or QA – Day Surgery dependent on the Patient Type. 
 

To transfer a task from the Pre\Scan Reconciliation Task Queue to the QA Task Queue, select a task 
from the Task Queue. 

 

 
 

Click Transfer Task  on the toolbar.  

 

The Transfer Task dialogue box will appear.  From the Task type list select the new task type (QA-Day 
Surgery or QA – Inpatient).  Click OK. 

   

 

 

 

 

 

 

Note:  The system allows you to transfer tasks in a Pending and On Hold status. 
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 Activity 4.5 – Add Encounter or Notes to a Task 

 

To add an encounter or task note to a task, select a task from the queue. 

 

Right-click and select Notes > Encounter Notes or Task Notes.  

  

 

The Note View Form is displayed.  Enter the note in the Contents pane. 

o If necessary, select the Permanent Note. 

  

 

Click Save ,  then Exit  on the toolbar. 

 

  

 

View the note in the Notes for Review Task pane. 
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 Activity 4.6 – Previewing and Printing Reports 

 

From the View menu select Options. The Options window is displayed. 

 

Click the Printing tab and select Print Detail Report or Print Summary Report.  Click OK. 

 

  

 

To preview the report click Print Preview on the toolbar.  

 

 

The Detail Report will look similar to this.   
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The Summary Report will look similar to this.   

  

 

 
 

To print directly from the report preview click Print  on the toolbar. 
 

o You can also click Print from the toolbar of the Task Queue. 
 

 


